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SUMMARY:  29 
Presented here is a method to design an augmented reality smartphone application for the 30 
visualization of anatomical three-dimensional models of patients using a 3D-printed reference 31 
marker. 32 
 33 
ABSTRACT: 34 
Augmented reality (AR) has great potential in education, training, and surgical guidance in the 35 
medical field. Its combination with three-dimensional (3D) printing (3DP) opens new 36 
possibilities in clinical applications. Although these technologies have grown exponentially in 37 
recent years, their adoption by physicians is still limited, since they require extensive 38 
knowledge of engineering and software development. Therefore, the purpose of this protocol is 39 
to describe a step-by-step methodology enabling inexperienced users to create a smartphone 40 
app, which combines AR and 3DP for the visualization of anatomical 3D models of patients with 41 
a 3D-printed reference marker. The protocol describes how to create 3D virtual models of a 42 
patient’s anatomy derived from 3D medical images. It then explains how to perform positioning 43 
of the 3D models with respect to marker references. Also provided are instructions for how to 44 
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3D print the required tools and models. Finally, steps to deploy the app are provided. The 45 
protocol is based on free and multi-platform software and can be applied to any medical 46 
imaging modality or patient. An alternative approach is described to provide automatic 47 
registration between a 3D-printed model created from a patient’s anatomy and the projected 48 
holograms. As an example, a clinical case of a patient suffering from distal leg sarcoma is 49 
provided to illustrate the methodology. It is expected that this protocol will accelerate the 50 
adoption of AR and 3DP technologies by medical professionals. 51 
 52 
INTRODUCTION:  53 
 54 
AR and 3DP are technologies that provide increasing numbers of applications in the medical 55 
field. In the case of AR, its interaction with virtual 3D models and the real environment benefits 56 
physicians in regards to education and training1–3, communication and interactions with other 57 
physicians4, and guidance during clinical interventions5–10. Likewise, 3DP has become a 58 
powerful solution for physicians when developing patient-specific customizable tools11–13 or 59 
creating 3D models of a patient’s anatomy, which can help improve preoperative planning and 60 
clinical interventions14,15.  61 
 62 
Both AR and 3DP technologies help to improve orientation, guidance, and spatial skills in 63 
medical procedures; thus, their combination is the next logical step. Previous work has 64 
demonstrated that their joint use can increase value in patient education16, facilitating 65 
explanations of medical conditions and proposed treatment, optimizing surgical workflow17,18 66 
and improving patient-to-model registration19. Although these technologies have grown 67 
exponentially in recent years, their adoption by physicians is still limited, since they require 68 
extensive knowledge of engineering and software development. Therefore, the purpose of this 69 
work is to describe a step-by-step methodology that enables the use of AR and 3DP by 70 
inexperienced users without the need for broad technical knowledge.  71 
 72 
This protocol describes how to develop an AR smartphone app that allows the superimposing of 73 
any patient-based 3D model onto a real-world environment using a 3D-printed marker tracked 74 
by the smartphone camera. In addition, an alternative approach is described to provide 75 
automatic registration between a 3D-printed biomodel (i.e., a 3D model created from a 76 
patient’s anatomy) and the projected holograms. The protocol described is entirely based on 77 
free and multi-platform software.  78 
 79 
In previous work, AR patient-to-image registration has been calculated manually5 with surface 80 
recognition algorithms10 or has been unavailable2. These methods have been considered 81 
somewhat limited when an accurate registration is required19. To overcome these limitations, 82 
this work provides tools to perform accurate and simple patient-to-image registration in AR 83 
procedures by combining AR technology and 3DP. 84 
 85 
The protocol is generic and can be applied to any medical imaging modality or patient. As an 86 
example, a real clinical case of a patient suffering from distal leg sarcoma is provided to 87 
illsutrate the methodology. The first step describes how to easily segment the affected 88 



   

   
 

anatomy from computed tomography (CT) medical images to generate 3D virtual models. 89 
Afterwards, positioning of the 3D models is performed, then the required tools and models are 90 
3D-printed. Finally, the desired AR app is deployed. This app allows for the visualization of 91 
patient 3D models overlaid on a smartphone camera in real-time. 92 
 93 
PROTOCOL:  94 
 95 
This study was performed in accordance with the principles of the 1964 Declaration of Helsinki 96 
as revised in 2013. The anonymized patient data and pictures included in this paper are used 97 
after written informed consent was obtained from the participant and/or their legal 98 
representative, in which he/she approved the use of this data for dissemination activities 99 
including scientific publications. 100 
 101 
1. Workstation set-up for segmentation, 3D models extraction, positioning, and AR app 102 
deployment 103 
 104 
NOTE: This protocol has been tested with the specific software version indicated for each tool. 105 
It is likely to work with newer versions, although it is not guaranteed. 106 

 107 
1.1. Use a computer with Microsoft Windows 10 or Mac OS as operating systems. 108 

 109 
1.2. Install the following tools from the corresponding websites per the official instructions: 110 
 111 
3D Slicer (v. 4.10.2): <https://download.slicer.org/>. 112 
Meshmixer (v. 3.5): <http://www.meshmixer.com/download.html>. 113 
Unity (v. 2019): <https://unity3d.com/get-unity/download>. 114 
(For iOS deployment only) Xcode (last version): <https://developer.apple.com/xcode/>. 115 
 116 
NOTE: All software tools required for completing the protocol can be freely downloaded for 117 
personal purposes. Software to be used in each step will be specifically indicated. 118 

 119 
1.3. Download data from the following GitHub repository, found at <https://github.com/BIIG-120 
UC3M/OpenARHealth>. 121 
 122 
NOTE: The repository contains the following folders: 123 
 124 
“/3DSlicerModule/”: 3D slicer module for positioning 3D models with respect to the 3D-printed 125 
marker. Used in section 3. Add the module into the 3D slicer following the instructions available 126 
at <https://github.com/BIIG-UC3M/OpenARHealth>. 127 
 128 
“/Data/PatientData/Patient000_CT.nrrd”: CT of a patient suffering from distal leg sarcoma. The 129 
protocol is described using this image as an example.  130 
 131 
“/Data/Biomodels/”: 3D models of the patient (bone and tumor). 132 

https://download.slicer.org/
http://www.meshmixer.com/download.html
https://unity3d.com/get-unity/download
https://developer.apple.com/xcode/
https://github.com/BIIG-UC3M/OpenARHealth
https://github.com/BIIG-UC3M/OpenARHealth


   

   
 

 133 
“/Data/Markers/”: Markers that will be 3D-printed, which will be detected by the AR 134 
application to position the virtual 3D models. There are two markers available. 135 
 136 
2. Biomodel creation 137 

 138 
NOTE: The goal of this section is to create 3D models of the patient’s anatomy. They will be 139 
obtained by applying segmentation methods to a medical image (here, using a CT image). The 140 
process consists of three different steps: 1) loading the patient data into 3D slicer software, 2), 141 
segmentation of target anatomy volumes, and 3) exportation of segmentation as 3D models in 142 
OBJ format. The resulting 3D models will be visualized in the final AR application.  143 
 144 
2.1. Load patient data (“/Data/PatientData/Patient000_CT.nrrd”) by dragging the medical 145 
image file into the 3D slicer software window. Click OK. The CT views (axial, sagittal, coronal) 146 
will appear on the corresponding windows.  147 
 148 
NOTE: The data used here is found in “nearly raw raster data” (NRRD) format, but 3D Slicer 149 
allows for loading of medical image format (DICOM) files. Go to the following link for further 150 
instructions, found at <https://www.slicer.org/wiki/Documentation/4.10/Training>. 151 
 152 
2.2. To segment the anatomy of the patient, go to the Segment Editor module in 3D slicer.  153 

 154 
2.2.1. A “segmentation” item is created automatically when entering the module. Select the 155 
desired volume (a medical image of the patient) in the Master Volume section. Then, right-click 156 
below on the Add button to create a segment.  A new segment will be created with the name 157 
“Segment_1”.  158 

 159 
2.2.2. There is a panel called Effects that contains a variety of tools to properly segment the 160 
target area of the medical image. Select the most convenient tool for the target and segment 161 
onto the image windows area.  162 

 163 
2.2.2.1. To segment the bone (tibia and fibula in this case), use the Threshold tool to set up 164 
minimum and maximum HU values from the CT image, which corresponds to bone tissue. By 165 
using this tool, other elements with HU outside these threshold values are removed, such as 166 
soft tissue.  167 
 168 
2.2.2.2. Use the Scissors tool to remove undesired areas, such as the bed or other anatomical 169 
structures, from the segmented mask. Segment the sarcoma manually using the Draw and 170 
Erase tools, since the tumor is difficult to contour with automatic tools. 171 

 172 
NOTE: To learn more details about the segmentation procedure, go to the link found at  173 
<https://www.slicer.org/wiki/Documentation/4.10/Training#Segmentation>. 174 
 175 
2.2.3. Click on the Show 3D button to view a 3D representation of the segmentation. 176 

https://www.slicer.org/wiki/Documentation/4.10/Training
https://www.slicer.org/wiki/Documentation/4.10/Training#Segmentation


   

   
 

 177 
2.3. Export the segmentation in a 3D model file format by going to the Segmentations module 178 
in 3D Slicer. 179 

 180 
2.3.1. Go to Export/import models and labelmaps. Select Export in the operation section and 181 
Models in the output type section. Click Export to finish and create the 3D model from the 182 
segmented area. 183 

 184 
2.3.2. Select SAVE (upper left) to save the model. Choose the elements to be saved. Then, 185 
change the file format of the 3D Model to “OBJ” within the File format column. Select the path 186 
where files will be stored and click on Save. 187 
 188 
2.4. Repeat steps 2.2 and 2.3 to create additional 3D models of different anatomical regions. 189 
 190 

NOTE: Pre-segmented models of the provided example can be found in the data previously 191 
downloaded in step 1.3 (“/Data/Biomodels/”). 192 

 193 
3. Biomodel positioning 194 
 195 
NOTE: In this section, the 3D models created in Section 2 will be positioned with respect to the 196 
marker for augmented reality visualization. The ARHealth: Model Position module from 3D 197 
Slicer will be used for this task. Follow the instructions provided in step 1.3 to add the module 198 
to 3D Slicer. There are two different alternatives to position the 3D models: “Visualization” 199 
mode and “Registration” mode. 200 
 201 
3.1. Visualization mode 202 
 203 
NOTE: Visualization mode allows positioning of the 3D patient models at any position with 204 
respect to the AR marker. With this option, the user are able to use the AR app to visualize 205 
biomodels using the 3D-printed AR marker as a reference. This mode may be used when 206 
precision is not required, and visualization of the virtual model can be displayed anywhere 207 
within the field-of-view of the smartphone camera and marker. 208 
 209 
3.1.1. Go to the ARHealth: Model Position module, and (in the initialization section) select 210 
Visualization mode. Click on Load Marker Model to load the marker for this option. 211 

 212 
3.1.2. Load the 3D models created in section 2 by clicking on the … button to select the path of 213 
the saved models from section 2. Then, click on the Load Model button to load it in 3D Slicer. 214 
Models must be loaded one at a time. To delete any models previously loaded, click on that 215 
model followed by the Remove Model button, or click Remove All to delete all models loaded 216 
at once.  217 

 218 
3.1.3. Click the Finish and Center button to center all models within the marker. 219 

 220 



   

   
 

3.1.4. The position, orientation, and scaling of the 3D models can be modified with respect to 221 
the marker with different slider bars (i.e., translation, rotation, scale). 222 

 223 
NOTE: There is an additional “Reset Position” button to reset the original position of the models 224 
before making any changes in the position. 225 

 226 
3.1.5. Save the models at this position by choosing the path to store the files and clicking the 227 
Save Models button. The 3D models will be saved with the extension name “_registered.obj”. 228 
 229 
3.2. Registration mode 230 
 231 
NOTE: Registration mode allows combining of the AR marker with one 3D biomodel at any 232 
desired position. Then, any section of the combined 3D models (that includes the AR marker) 233 
can be extracted and 3D-printed. All biomodels will be displayed in the AR app using this 234 
combined 3D-printed biomodel as a reference. This mode allows the user to easily register the 235 
patient (here, a section of the patient’s bone) and virtual models using a reference marker.  236 
 237 
3.2.1. Go to the ARHealth: Model Position module, and (in the initialization section) select 238 
Registration mode. Click on Load Marker Model to load the marker for this option. 239 

 240 
3.2.2. Load the models as done in step 3.1.2. 241 
 242 
3.2.3. Move the 3D models and ensure their intersection with the supporting structure of the 243 
cube marker, since these models will be combined and 3D-printed later. The height of the 244 
marker base can be modified. The position, orientation, and scaling of the 3D models can be 245 
modified with respect to the marker with different slider bars (i.e., translation, rotation, scale). 246 

 247 
3.2.4. Save the models at this position by choosing the path to store the files and clicking the 248 
Save Models button. The 3D models will be saved with the extension name “_registered.obj”. 249 
 250 
3.2.5. The anatomy model may be too large. If so, cut the 3D model around the marker adaptor 251 
and 3D-print only a section of the combination of both models using Meshmixer software. 252 
 253 
3.2.6. Open Meshmixer and load the biomodel and supporting structure of the cube marker 254 
model saved in step 3.2.5. Combine these models by selecting both models in the Object 255 
Browser window. Click on the Combine option in the tool window that has just appeared in the 256 
upper left corner. 257 
 258 
3.2.7. In Meshmixer, use the Plane Cut tool under the Edit menu to remove unwanted sections 259 
of the model that will not be 3D-printed. 260 
 261 
3.2.8. To save the model to be 3D-printed, go to File > Export and select the desired format. 262 
 263 

4. 3D printing 264 



   

   
 

 265 
NOTE: The aim of this step is to 3D-print the physical models required for the final AR 266 
application. The marker to be detected by the application and the different objects needed 267 
depend on the mode selected in section 3. Any material can be used for 3D printing for the 268 
purpose of this work, when following the color material requirements requested at each step. 269 
Polylactic acid (PLA) or acrylonitrile butadiene styrene (ABS) are both sufficient choices. 270 
 271 
4.1. Use a 3D printer to print the cubic marker. If a dual extruder 3D printer is not available, skip 272 
to step 4.2. Use a dual extruder 3D printer specifically to print the two-color marker provided in 273 
“Data/Markers/Marker1_TwoColorCubeMarker/”. In the 3D printing software, select a white 274 
color material for the file “TwoColorCubeMarker_WHITE.obj” and black color material for 275 
“TwoColorCubeMarker_BLACK.obj”. 276 
 277 
NOTE: For better marker detection, print on high-quality mode with a small layer height. 278 
 279 
4.2. If a dual extruder 3D printer is not available and step 4.1 was not performed, follow this 280 
step to print a 3D-printed marker with stickers as an alternative by doing the following: 281 
 282 
4.2.1. Use a 3D printer to print the file “Data/Markers/ Marker2_StickerCubeMarker/ 283 
StickerCubeMarker_WHITE.obj” with white color material.  284 
 285 
4.2.2. Use a conventional printer to print the file “Data/Markers/ 286 
Marker2_StickerCubeMarker/Stickers.pdf” on sticker paper. Then, use any cutting tool to 287 
precisely cut the images though the black frame by removing the black lines.  288 
 289 
NOTE: It is recommended to use sticker paper to obtain a higher quality marker. However, the 290 
images can be printed on regular paper, and a common glue stick can be used to paste the 291 
images on the cube. 292 
 293 
4.2.3. Place stickers in the 3D-printed cube obtained in step 4.2.1 in the corresponding order 294 
following instructions from the document “Data/Markers/ 295 
Marker2_StickerCubeMarker/Stickers.pdf”.  296 

 297 
NOTE: Stickers are smaller than the face of the cube. Leave a 1.5 mm frame between the sticker 298 
and edge of the face. “Data/Markers/Marker2_StickerCubeMarker/StickerPlacer.stl” can be 3D-299 
printed to guide the sticker positioning and exactly match the center of the cube face.  300 

 301 
4.3. 3D-print the adaptors, depending on the mode selected in section 3. 302 

 303 
4.3.1. If Visualization mode (section 3.1), was selected, 3D-print “Data/3DPrinting/Option1/ 304 
MarkerBaseTable.obj”, which is a base adaptor used to place the marker in vertical position on 305 
a horizontal surface. 306 

 307 
4.3.2. If Registration mode (section 3.2) was selected, 3D-print the model created in step 3.2.8 308 



   

   
 

with the marker adaptor attached.  309 
 310 

NOTE: 3D printed objects from step 4.2 can be printed in any color material. 311 
 312 
5. AR app deployment 313 
 314 
NOTE: The goal of this section is to design a smartphone app in Unity engine that includes the 315 
3D models created in the previous sections and deploy this app on a smartphone. A Vuforia 316 
Development License Key (free for personal use) is required for this step. The app can be 317 
deployed on Android or iOS devices. 318 
 319 
5.1. Create a Vuforia Developer account to obtain a license key to use their libraries in Unity. Go 320 
to the link found at <https://developer.vuforia.com/vui/auth/register> and create an account.  321 
 322 
5.1.1. Go to the link found at <https://developer.vuforia.com/vui/develop/Licenses> and select 323 
Get Development Key. Then, follow the instructions to add a free development license key into 324 
the user´s account. 325 

 326 
5.1.2. In the License Manager menu, select the key created in the previous step and copy the 327 
provided key, which will be used in step 5.3.3. 328 

 329 
5.2. Set up the smartphone. 330 
 331 
5.2.1. To get started with Unity and Android devices, go to the link found at 332 
<https://docs.unity3d.com/Manual/android-GettingStarted.html>. 333 
 334 
5.2.2. To get started with Unity and iOS devices, go to the link found at 335 
<https://docs.unity3d.com/Manual/iphone-GettingStarted.html>. 336 

 337 
5.3. Set up a Unity Project for the AR app by first opening Unity v.2019 and creating a new 3D 338 
project. Then, under Build Settings in the File menu, switch the platform to either an Android 339 
or iOS device. 340 
 341 
5.3.1. Enable Vuforia into the project by selecting Edit > Project Setting > Player Settings > XR 342 
Settings and checking the box labeled Vuforia Augmented Reality Support. 343 
 344 
5.3.2. Create an “ARCamera” under Menubar > GameObject > Vuforia > ARCamera and import 345 
Vuforia components when prompted. 346 
 347 
5.3.3. Add the Vuforia License Key into Vuforia Configuration settings by selecting the 348 
Resources folder and clicking on Vuforia Configuration. Then, in the App License Key section, 349 
paste the key copied in section 5.1.2. 350 

 351 
5.3.4. Import the Vuforia Target file provided in “/Data/Vuforia/ AR_Cube_3x3x3.unitypackage” 352 

https://docs.unity3d.com/Manual/android-GettingStarted.html
https://docs.unity3d.com/Manual/iphone-GettingStarted.html


   

   
 

into Unity, which contains the files that Vuforia requires to detect the markers described in 353 
section 4. 354 
 355 
5.3.5. Create a Vuforia MultiTarget under Menubar > GameObject > Vuforia > MultiTarget.  356 
 357 
5.3.6. Select the marker type that will be used for detection by clicking on the MultiTarget 358 
created in the previous step. In the Database option under Multi Target Behaviour, select 359 
ARHealth_3DPrintedCube_30x30x30. In the Multi Target option under Multi Target 360 
Behaviour, select either TwoColorCubeMarker or StickerCubeMarker, depending on the 361 
marker created in section 4. 362 
 363 
5.3.7. Load the 3D models created in section 3 into Unity Scene under MultiTarget by creating a 364 
new folder with the name “Models” under the “Resources” folder. Drag the 3D models into this 365 
folder. Once loaded in Unity, drag them under the “MultiTarget” item created in step 5.3.5. This 366 
will make them dependent on the marker. 367 
 368 
NOTE: Models should be visible in the Unity 3D view scene. 369 
 370 
5.3.8. Change the colors of the 3D models by creating a new material and assigning the new 371 
materials to the models.  372 
 373 
5.3.8.1. Create a new folder named “Materials” under the “Resources” folder by going to 374 
Menubar > Assets > Create > Material. Select the material and change the color in the 375 
configuration section. Then, drag the file under the 3D model hierarchy. 376 
 377 
5.3.9. Optional: if there is a webcam available, click on the play button located in the upper-378 
middle portion to test its application on the computer. If the marker is visible to the webcam, it 379 
should be detected, and the 3D models should appear in the scene. 380 
 381 
5.3.10. If an Android smartphone is used for app deployment, go to File > Build Settings in 382 
Unity, and select the plugged phone from the list. Select Deploy and Run. Save the file with 383 
extension .apk on the computer and allow the process to finish. Once deployment is done, the 384 
app should be on the phone and ready to run. 385 

 386 
NOTE: This protocol has been tested on Android v.8.0 Oreo or above. Correct functionality is 387 
not guaranteed for older versions. 388 
 389 
5.3.11. If the app will be deployed in an iOS device, go to File > Build Settings in Unity and 390 
select Run. Select the path to save the app files. Allow the process to finish. Go to the saved 391 
folder and open the file with the extension “.projectxcode”. 392 
 393 
5.3.11.1. In Xcode, follow the instructions from step 5.2.2 to complete deployment. 394 
 395 



   

   
 

NOTE: For more information about Vuforia in Unity, go to the link found at 396 
<https://Library.vuforia.com/articles/Training/getting-started-with-vuforia-in-unity.html>. 397 

 398 
6. App visualization 399 
 400 
6.1. Open the installed app, which will use the smartphone’s camera. When running the app, 401 
look at the marker with the camera from a short distance away (40 cm minimum). Once the app 402 
detects the marker, the 3D models created in previous steps should appear exactly at the 403 
location defined during the procedure on the smartphone screen. 404 
 405 
NOTE: Illumination can alter the precision of marker detection. It is recommended to use the 406 
app in environments with good lighting conditions.  407 
 408 
REPRESENTATIVE RESULTS: 409 
 410 
The protocol was applied to data from a patient suffering from distal leg sarcoma in order to 411 
visualize the affected anatomical region from a 3D perspective. Using the method described in 412 
section 2, the portion of the affected bone (here, the tibia and fibula) and tumor were 413 
segmented from the patient’s CT scan. Then, using the segmentation tools from 3D Slicer, two 414 
biomodels were created: the bone (section of the tibia and fibula) (Figure 1A) and tumor 415 
(Figure 1B).  416 
 417 
Next, the two 3D models were positioned virtually with respect to the marker for optimal 418 
visualization. Both modes described in section 3 were followed for this example. For 419 
visualization mode, the models were centered in the upper face of the marker (Figure 2). For 420 
registration mode, the marker adaptor was positioned in the bone (specifically, the tibia [Figure 421 
3]). Then, a small section of the tibia was selected to be 3D-printed with a 3D marker adaptor 422 
(Figure 4). An Ultimaker 3 extended 3D printer with PLA material was used to create the 3D-423 
printed markers (Figure 5A,B), marker holder base (Figure 5C) for the “visualization” mode, and 424 
section of the tibia for “registration” mode (Figure 5D). Figure 5E shows how the marker was 425 
attached to the “visualization” mode 3D-printed base. Figure 5F shows the attachment with the 426 
“registration” mode 3D-printed biomodel. Finally, Unity was used to create the app and deploy 427 
it in the smartphone. 428 
  429 
Figure 6 shows how the app worked for “visualization” mode. The hologram was accurately 430 
located in the upper part of the cube as previously defined. Figure 7 shows the application for 431 
“registration” mode, in which the app positioned the complete bone model on top of the 3D-432 
printed section. The final visualization of the holograms was clear and realistic, maintained the 433 
real sizes of the biomodels, and positioned accurately. When using the smartphone application, 434 
the AR marker needs to be visible by the camera for the app to correctly display the holograms. 435 
In addition, the light conditions in the scene must be of good quality and constant for proper 436 
marker detection. Bad light conditions or reflections on the marker surface hinder the tracking 437 
of the AR marker and cause malfunctioning of the app.  438 
  439 

https://library.vuforia.com/articles/Training/getting-started-with-vuforia-in-unity.html


   

   
 

The time required to create the app depends on several factors. The duration of section 1 is 440 
limited by the download speed. Regarding anatomy segmentation (section 2), factors affecting 441 
segmentation time include complexity of the region and medical imaging modality (i.e., CT is 442 
easily segmented, while MRI is more difficult). For the representative example of the tibia, 443 
approximately 10 min was required to generate both 3D models from the CT scan. Biomodel 444 
positioning (section 3) is simple and straightforward. Here, it took approximately 5 min to 445 
define the biomodel position with respect to the AR marker. For the 3D printing step, the 446 
duration is highly dependent on the selected mode. The “dual color marker” was manufactured 447 
at high quality in a period of 5 h and 20 min. The “sticker marker” was manufactured in a period 448 
of 1 h and 30 min, plus the time required to paste the stickers. The final step for app 449 
development can be time-consuming for those with no previous experience in Unity, but it can 450 
be easily completed following the protocol steps. Once the AR markers have been 3D-printed, 451 
the development of an entirely new AR app can be performed in less than 1 h. This duration can 452 
be further reduced with additional experience.  453 
 454 
FIGURE AND TABLE LEGENDS: 455 
 456 
Figure 1: Representation of 3D models created from CT image of a patient suffering from 457 
distal leg sarcoma. (A) Bone tissue represented in white (tibia and fibula). (B) Tumor 458 
represented in red. 459 
 460 
Figure 2: Results showing how “visualization” mode in 3D Slicer positions the virtual 3D 461 
models of the bone and tumor with respect to 3D-printed marker reference. The patient 3D 462 
models (A) are positioned above the upper face of the marker cube (B). 463 
 464 
Figure 3: Results showing how “registration” mode in 3D Slicer positions the virtual 3D 465 
models of the bone and tumor (A) with respect to 3D-printed marker reference (B). The 466 
marker adaptor is attached to the bone tissue model. 467 
 468 
Figure 4: Small section of the bone tissue and 3D marker adaptor. The two components are 469 
combined then 3D-printed. 470 
 471 
Figure 5: 3D printed tools required for the final application. (A) “Two color cube marker” 3D-472 
printed with two colors of materials. (B) “Sticker cube marker” 3D-printed, with stickers pasted. 473 
(C) Marker base cube adaptor. (D) Section of the patient’s bone tissue 3D model and marker 474 
cube adaptor. (E) “Sticker cube marker” placed in the marker base cube adaptor. (F) “Two color 475 
cube marker” placed in the marker adaptor attached to the patient’s anatomy. 476 
 477 
Figure 6: App display when using “visualization” mode. The patient’s affected anatomy 3D 478 
models are positioned above the upper face of the 3D-printed cube. 479 
 480 
Figure 7: AR visualization when using “registration” mode. The 3D-printed marker enables 481 
registration of the 3D-printed biomodel with the virtual 3D models. 482 
 483 



   

   
 

DISCUSSION: 484 
 485 
AR holds great potential in education, training, and surgical guidance in the medical field. Its 486 
combination with 3D printing opens may new possibilities in clinical applications. This protocol 487 
describes methodology that enables inexperienced users to create a smartphone app 488 
combining AR and 3DP for the visualization of anatomical 3D models of patients with 3D-489 
printed reference markers. 490 
 491 
In general, one of the most interesting clinical applications of AR and 3DP is to improve patient-492 
to-physician communication by giving the patient a different perspective of the case, improving 493 
explanations of specific medical conditions or treatments. Another possible application includes 494 
surgical guidance for target localization, in which 3D-printed patient-specific tools (with a 495 
reference AR marker attached) can be placed on rigid structures (i.e., bone) and used as a 496 
reference for navigation. This application is especially useful for orthopedic and maxillofacial 497 
surgical procedures, in which bone tissue surface is easily accessed during surgery.  498 
 499 
The protocol starts with section 1, describing the workstation set-up and software tools 500 
necessary. Section 2 describes how to use 3D Slicer software to easily segment target 501 
anatomies of the patient from any medical imaging modality to obtain 3D models. This step is 502 
crucial, as the virtual 3D models created are those displayed in the final AR application. 503 
  504 
In section 3, 3D Slicer is used to register the 3D models created in the previous section with an 505 
AR marker. During this registration procedure, patient 3D models are efficiently and simply 506 
positioned with respect to the AR marker. The position defined in this section will determine 507 
the hologram relative position in the final app. It is believed that this solution reduces 508 
complexity and multiplies the possible applications. Section 3 describes two different options to 509 
define the spatial relationships between the models and AR markers: “visualization” and 510 
“registration” mode. The first option, “visualization” mode, allows the 3D models to be 511 
positioned anywhere with respect to the marker and displayed as the whole biomodel. This 512 
mode provides a realistic, 3D perspective of the patient’s anatomy and allows moving and 513 
rotating of the biomodels by moving the tracked AR marker. The second option, “registration” 514 
mode, allows attachment and combining of a marker adaptor to any part of the biomodel, 515 
offering an automatic registration process. With this option, a small section of the 3D model, 516 
including the marker adaptor, can be 3D-printed, and the app can display the rest of the model 517 
as a hologram.  518 
  519 
Section 4 provides guidelines for the 3D printing process. First, the user can choose between 520 
two different markers: the “dual color marker” and “sticker marker”. The whole “dual color 521 
marker” can be 3D-printed but requires a dual extruder 3D printer. In case this printer is not 522 
available, the “sticker marker” is proposed. This is a simpler marker that can be obtained by 3D-523 
printing the cubic structure, then pasting the images of the cube with sticker paper or sticker 524 
glue. Furthermore, both markers were designed with extensible sections to perfectly fit in a 525 
specific adaptor. Thus, the marker can be reused in several cases.  526 
  527 



   

   
 

Section 5 describes the process to create a Unity project for AR using the Vuforia software 528 
development kit. This step may be the hardest portion for users with no programming 529 
experience, but with these guidelines, it should be easier to obtain the final application that is 530 
presented in section 6. The app displays the patient’s virtual models over the smartphone 531 
screen when the camera recognizes the 3D-printed marker. In order for the app to detect the 532 
3D marker, a minimum distance of approximately 40 cm or less from the phone to marker as 533 
well as good lighting conditions are required. 534 
  535 
The final application of this protocol allows the user to choose the specific biomodels to 536 
visualize and in which positions. Addtionally, the app can perform automatic patient-hologram 537 
registration using a 3D-printed marker and adaptor attached to the biomodel. This solves the 538 
challenge of registering virtual models with the environment in a direct and convenient 539 
manner. Moreover, this methodology does not require broad knowledge of medical imaging or 540 
software development, does not depend on complex hardware and expensive software, and 541 
can be implemented over a short time period. It is expected that this method will help 542 
accelerate the adoption of AR and 3DP technologies by medical professionals. 543 
 544 
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Name of Material/Equipment Company Catalog Number

3D Printing material: Acrylonitrile 

Butadiene Styrene (ABS)

3D Printing material: Polylactic 

Acid (PLA)

3D Slicer

Android Alphabet, Inc.

Autodesk Meshmixer Autodesk, Inc.

iPhone OS Apple, Inc.

Ultimaker 3 Extended Ultimaker BV

Unity Unity Technologies

Xcode Apple, Inc.
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Comments/Description

Thermoplastic polymer material usually used in domestic 

3D printers.

Bioplastic material usually used in domestic 3D printers.

Open-source software platform for medical image 

informatics, image processing, and three-dimensional 

visualization
Android is a mobile operating system developed by Google. 

It is based on a modified version of the Linux kernel and 

other open source software, and is designed primarily 

for touchscreen mobile devices such 
Meshmixer is state-of-the-art software for working with 

triangle meshes. Free software.

iPhone OS is a mobile operating system created and 

developed by Apple Inc. exclusively for its hardware.

Fused deposition modeling 3D printer.
Unity is a real-time development platform to create 3D, 2D 

VR & AR visualizations for Games, Auto, Transportation, 

Film, Animation, Architecture, Engineering & more. Free 

software.
Xcode is a complete developer toolset for creating apps for 

Mac, iPhone, iPad, Apple Watch, and Apple TV. Free 

software.
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4. Retention of Rights in Article. Notwithstanding 
the exclusive license granted to JoVE in Section 3 above, the 
Author shall, with respect to the Article, retain the non-
exclusive right to use all or part of the Article for the non-
commercial purpose of giving lectures, presentations or 
teaching classes, and to post a copy of the Article on the 
Institution’s website or the Author’s personal website, in 
each case provided that a link to the Article on the JoVE 
website is provided and notice of JoVE’s copyright in the 
Article is included. All non-copyright intellectual property 
rights in and to the Article, such as patent rights, shall 
remain with the Author. 
5. Grant of Rights in Video – Standard Access. This 
Section 5 applies if the “Standard Access” box has been 
checked in Item 1 above or if no box has been checked in 
Item 1 above. In consideration of JoVE agreeing to produce, 
display or otherwise assist with the Video, the Author 
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below, JoVE is and shall be the sole and exclusive owner of 
all rights of any nature, including, without limitation, all 
copyrights, in and to the Video. To the extent that, by law, 
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have any rights of any nature in or to the Video, the Author 
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now known or hereafter developed (including without 
limitation in print, digital and electronic form) throughout 
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foregoing rights may be exercised in all media and formats, 
whether now known or hereafter devised, and include the 
right to make such modifications as are technically 
necessary to exercise the rights in other media and formats. 
For any Video to which this Section 6 is applicable, JoVE and 
the Author hereby grant to the public all such rights in the 
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7. Government Employees. If the Author is a United 
States government employee and the Article was prepared 
in the course of his or her duties as a United States 
government employee, as indicated in Item 2 above, and 
any of the licenses or grants granted by the Author 
hereunder exceed the scope of the 17 U.S.C. 403, then the 
rights granted hereunder shall be limited to the maximum 

rights permitted under such statute. In such case, all 
provisions contained herein that are not in conflict with 
such statute shall remain in full force and effect, and all 
provisions contained herein that do so conflict shall be 
deemed to be amended so as to provide to JoVE the 
maximum rights permissible within such statute. 
8. Protection of the Work. The Author(s) authorize 
JoVE to take steps in the Author(s) name and on their behalf 
if JoVE believes some third party could be infringing or 
might infringe the copyright of either the Author’s Article 
and/or Video. 
9. Likeness, Privacy, Personality. The Author hereby 
grants JoVE the right to use the Author’s name, voice, 
likeness, picture, photograph, image, biography and 
performance in any way, commercial or otherwise, in 
connection with the Materials and the sale, promotion and 
distribution thereof. The Author hereby waives any and all 
rights he or she may have, relating to his or her appearance 
in the Video or otherwise relating to the Materials, under 
all applicable privacy, likeness, personality or similar laws. 
10. Author Warranties. The Author represents and 
warrants that the Article is original, that it has not been 
published, that the copyright interest is owned by the 
Author (or, if more than one author is listed at the beginning 
of this Agreement, by such authors collectively) and has not 
been assigned, licensed, or otherwise transferred to any 
other party. The Author represents and warrants that the 
author(s) listed at the top of this Agreement are the only 
authors of the Materials. If more than one author is listed 
at the top of this Agreement and if any such author has not 
entered into a separate Article and Video License 
Agreement with JoVE relating to the Materials, the Author 
represents and warrants that the Author has been 
authorized by each of the other such authors to execute this 
Agreement on his or her behalf and to bind him or her with 
respect to the terms of this Agreement as if each of them 
had been a party hereto as an Author. The Author warrants 
that the use, reproduction, distribution, public or private 
performance or display, and/or modification of all or any 
portion of the Materials does not and will not violate, 
infringe and/or misappropriate the patent, trademark, 
intellectual property or other rights of any third party. The 
Author represents and warrants that it has and will 
continue to comply with all government, institutional and 
other regulations, including, without limitation all 
institutional, laboratory, hospital, ethical, human and 
animal treatment, privacy, and all other rules, regulations, 
laws, procedures or guidelines, applicable to the Materials, 
and that all research involving human and animal subjects 
has been approved by the Author's relevant institutional 
review board. 
11. JoVE Discretion. If the Author requests the 
assistance of JoVE in producing the Video in the Author’s 
facility, the Author shall ensure that the presence of JoVE 
employees, agents or independent contractors is in 
accordance with the relevant regulations of the Author's 
institution. If more than one author is listed at the 
beginning of this Agreement, JoVE may, in its sole 
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discretion, elect not take any action with respect to the 
Article until such time as it has received complete, executed 
Article and Video License Agreements from each such 
author. JoVE reserves the right, in its absolute and sole 
discretion and without giving any reason therefore, to 
accept or decline any work submitted to JoVE. JoVE and its 
employees, agents and independent contractors shall have 
full, unfettered access to the facilities of the Author or of 
the Author’s institution as necessary to make the Video, 
whether actually published or not. JoVE has sole discretion 
as to the method of making and publishing the Materials, 
including, without limitation, to all decisions regarding 
editing, lighting, filming, timing of publication, if any, 
length, quality, content and the like.  
12. Indemnification. The Author agrees to indemnify 
JoVE and/or its successors and assigns from and against any 
and all claims, costs, and expenses, including attorney’s 
fees, arising out of any breach of any warranty or other 
representations contained herein. The Author further 
agrees to indemnify and hold harmless JoVE from and 
against any and all claims, costs, and expenses, including 
attorney’s fees, resulting from the breach by the Author of 
any representation or warranty contained herein or from 
allegations or instances of violation of intellectual property 
rights, damage to the Author’s or the Author’s institution’s 
facilities, fraud, libel, defamation, research, equipment, 
experiments, property damage, personal injury, violations 
of institutional, laboratory, hospital, ethical, human and 
animal treatment, privacy or other rules, regulations, laws, 
procedures or guidelines, liabilities and other losses or 
damages related in any way to the submission of work to 
JoVE, making of videos by JoVE, or publication in JoVE or 
elsewhere by JoVE. The Author shall be responsible for, and 
shall hold JoVE harmless from, damages caused by lack of 
sterilization, lack of cleanliness or by contamination due to 

the making of a video by JoVE its employees, agents or 
independent contractors. All sterilization, cleanliness or 
decontamination procedures shall be solely the 
responsibility of the Author and shall be undertaken at the 
Author’s expense. All indemnifications provided herein 
shall include JoVE’s attorney’s fees and costs related to said 
losses or damages. Such indemnification and holding 
harmless shall include such losses or damages incurred by, 
or in connection with, acts or omissions of JoVE, its 
employees, agents or independent contractors. 
13. Fees. To cover the cost incurred for publication, 
JoVE must receive payment before production and 
publication of the Materials. Payment is due in 21 days of 
invoice. Should the Materials not be published due to an 
editorial or production decision, these funds will be 
returned to the Author. Withdrawal by the Author of any 
submitted Materials after final peer review approval will 
result in a US$1,200 fee to cover pre-production expenses 
incurred by JoVE. If payment is not received by the 
completion of filming, production and publication of the 
Materials will be suspended until payment is received. 
14. Transfer, Governing Law. This Agreement may be 
assigned by JoVE and shall inure to the benefits of any of 
JoVE’s successors and assignees. This Agreement shall be 
governed and construed by the internal laws of the 
Commonwealth of Massachusetts without giving effect to 
any conflict of law provision thereunder. This Agreement 
may be executed in counterparts, each of which shall be 
deemed an original, but all of which together shall be 
deemed to me one and the same agreement. A signed copy 
of this Agreement delivered by facsimile, e-mail or other 
means of electronic transmission shall be deemed to have 
the same legal effect as delivery of an original signed copy 
of this Agreement.
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Rebuttal Document 
 

Manuscript JoVE60618 
 
Title: Combining Augmented Reality and 3D Printing to Display Patient Models on Your 
Smartphone 
 

We would like to thank the reviewers and the editorial for their insightful comments and their interest in 
our work.  

First, we would like to summarize the major changes made for the paper revision:  

- In the protocol section, the levels of subtitles have been modified to have a more appropriate format 
following the editorial instructions. Now sublevels 4 are sparingly used. 

- Segmentation procedure in 2.2.2 is now more deeply explained. 

- A new paragraph has been added in the introduction section to give a clearer vision of the proposed 
method in the context of the state-of-the-art. 

- The introductory paragraph of step 3 of the protocol section has been modified to improve the 
explanation of “Visualization” and “Registration” modes. 

- Possible applications of our method are discussed in a new paragraph in the discussion section. 

- Software improvements in the repository provided for the 3D Slicer Module “AR Health: Model Position”. 
A new button has been added for restarting the process without having to restart 3D Slicer. 

- Figures 2 and 3 have been updated, highlighting different elements in the image.  

 

In the following pages of the document, you will find a separate answer to each reviewer’s comments. 

  

Rebuttal Letter Click here to access/download;Rebuttal
Letter;RebuttalDocument.docx

https://www.editorialmanager.com/jove/download.aspx?id=1111550&guid=836a1ffc-3aef-4e43-96b0-74912a0f6aca&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1111550&guid=836a1ffc-3aef-4e43-96b0-74912a0f6aca&scheme=1


Editorial comments: 
 
We would like to thank the Editorial for their insightful review of the manuscript and for their 
comments. 
 

General: 
1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are 
no spelling or grammar issues. 
2. Please limit the use of personal pronouns (you, your 
3. Please include email addresses for all authors in the manuscript. 
 
Answer: 
1. We apologize for any spelling or grammar issues. The paper has been reviewed again and 

corrected. 
2. The use of personal pronouns has been reduced or avoided. Examples can be found in steps 

2.2.1, 3.1.4, 3.2.3, 3.2.5, 4.2, 5.1.2, 5.2, 5.2.9.2, 5.3.10, 5.3.12.1.1., 6. All these steps are 
referenced to the first version of the manuscript. 

3. Email addresses for all authors have been included in “Authors and Affiliations” section. 
 

Protocol: 
1. Please include an ethics statement before the numbered protocol steps, indicating that the 
protocol follows the guidelines of your institution’s human research ethics committee. 
2. If possible, please limit substeps to no more than 4 levels (e.g., 1.1.1.1), with a 4th level used 
sparingly. 
3. For each protocol step, please ensure you answer the “how” question, i.e., how is the step 
performed? Alternatively, add references to published material specifying how to perform the 
protocol action. If revisions cause a step to have more than 2-3 actions and 4 sentences per step, 
please split into separate steps or substeps. 
 
Answer: 
1. The following ethics statement has been included before the numbered protocol steps: “This 

study was performed in accordance with the principles of the 1964 Declaration of Helsinki as 
revised in 2013. The anonymized patient data and pictures included in this paper are used 
after written informed consent was obtained from the participant and/or their legal 
representative, where he/she approved the use of this data for dissemination activities 
including scientific publications.”  

2. Most of the level 4 steps have been removed to higher-level steps. 
3. The manuscript steps and substeps have been modified to a more appropriated format 

following the instructions given by the Editorial.  
- Step 3.1.2 has been split, adding step 3.1.3, to avoid explaining too many actions in 

the same substep. 
- Step 3.2.5 and its substeps have been modified to level 3 substeps in order to avoid 

level 4 steps. “How” question has been answered specifically in some substeps. 



- Steps and substeps from 4.1. have been extended to steps 4.1 and 4.2. 
- Substeps in steps 5.3 have been adapted to avoid level 4 steps. 

 

Table of Materials: 
1. Please ensure the Table of Materials has information on all materials and equipment used, 
especially those mentioned in the Protocol. 
 
Answer: 
1. The Table of Materials has been modified by adding new materials that were not previously 

included. 
  



Reviewers’ comments 
 
Reviewer #1 
Manuscript Summary: 
The authors describe a method for presenting segmented medical images in an augmented reality 
smartphone app with virtual content registered to a 3D printed model. Registration is performed 
by manually adjusting a virtual model to a Vuforia marker 3D model. 
Major Concerns: 
None. 
Minor Concerns: 
Item 2.2.2 summarizes the segmentation details with a link to the Slicer documentation on 
segmentation. Although this is an acceptable description, I would prefer to see 2-4 sentences on 
the specific effects the authors used to segment the distal leg sarcoma images. Or even one 
summary summarizing the effects used: "To segment the desired patient geometry, we used the 
threshold, etc... effects." 
 
Answer: 
We would like to thank Reviewer #1 for his time on reading and commenting on our paper. 
Now we will proceed to answer the reviewer’s minor concerns: 
 
Regarding the segmentation step in item 2.2.2, we agree with the reviewer that summarizing the 
segmentation procedure with a link to Slicer documentation tutorial may not be enough to show 
a user how to segment properly the proposed patient case. Therefore, a new substep 2.2.2.1 has 
been added explaining briefly which tools were used from the Slicer Segmentation module to 
finally obtain the given 3D models of the patient. The added step is the following: “2.2.2.1 To 
segment the bone (tibia and fibula in this case), the “Threshold” tool was used to set up a 
minimum and a maximum HU value from the CT image which correspond to bone tissue. By using 
this tool, other elements with HU outside these threshold values are removed, such as soft tissue. 
Then, “Scissors” tool was used to remove some undesired areas such as the bed or other 
anatomical structures from the segmented mask. The sarcoma region was segmented manually 
using “Draw” and “Erase” tools since the tumor is difficult to contour with automatic tools”.  



Reviewer #2 
Manuscript Summary: 
This article proposes a method to display AR scene based on markers on a smartphone. A step-
by-step methodology was described to realize this work. 3D slicer was used to segment and 
reconstruct the anatomical 3D models of patients from CT or MR images. An AR Health module 
was also developed to design the location relationship between marker and visual 3D models 
through two modes of Visualization and Registration. Meshmixer was used to modify the 
combination of both models. Then, the physical models required were 3D printed for the final AR 
application. An AR smartphone app in Unity engine was designed and deployed on Android or iOS 
devices. Finally, a real clinical case of a patient suffering from a distal leg sarcoma was to describe 
the propose methodology. 
This manuscript is well organized.  
My major concerns are as follows: 
1. The proposed method is not clear. Compared with other work about AR using smartphone, the 
differences and similarities among the proposed method and other AR methods should be 
described more clearly. Using markers to display AR scene has been proposed in previous articles. 
 
2. The accuracy of AR in the proposed method is not described. The author could show an in-situ 
superposition of 3D images on patients. Actually, it is very different to install the marker on bones 
and on deformed tissues. Tissue deformation affects registration accuracy. So, please give 
examples of some suitable clinical applications. 
 
3. In AR Health module, both Visualization and Registration modes obtain the location of the 
marker and the 3D models by translating and rotating them. It is hoped that the differences 
between the two operations can be further explained. 
 
4. The proposed method seems to be a combination of several software and the existing methods. 
For some diseases, medical image segmentation is difficult, especially for inexperienced doctors. 
Also, the process described in this manuscript is complicated. Authors may describe each process 
simply and express them in pictures. 
 
5. I have tried the AR Health module, which can only be executed once and needs further 

optimization. For examples, it cannot return to remove or add models after “Finish and Center”, 
and the registration process cannot be performed after the visualization process. 
 
Answer: 
We would like to thank Reviewer #2 for his time on reading and commenting insightfully our 
paper. In the following paragraphs we answer all reviewer’s major concerns: 
 
1. The purpose of this paper is not to present a new method for showing AR scenes with data 

coming from medical images but to offer inexperienced users a complete protocol on how to 
use AR technology for that purpose. We include several references showing how this 
technology has been used previously in the biomedical field, providing context to the reader 
about the interest of these solutions. We have considered that a JOVE video and a full step-



by-step protocol will help novel users to try AR since our method is based on inexpensive 
tools. Markers-based AR has been proposed before and has shown its potential, particularly 
in one of our previous papers. With this protocol, we want to encourage more users to try 
this technology thanks to its simplicity. The novelty of our work is that we facilitate image-to-
world registration, which has been previously considered a limiting factor. We have added a 
paragraph in the introduction section of the paper to better answer the reviewer’s concerns. 
  

2. We have previously evaluated the accuracy of the proposed protocol on a phantom in 
reference19, where we used HoloLens as the AR device. The protocol described in the paper 
is not intended to introduce any accuracy measure, but the reader can check our reference 
to better understand the limitations of the protocol. The limitations regarding the use of a 
marker attached to the bone were also identified in our previous paper. The referee is correct 
when pointing out that a marker attached to soft tissue would limit the utility of the protocol. 
We have added a paragraph in the discussion section with more clinical examples of the use 
of the proposed methodology: “In general, one of the most interesting clinical applications of 
AR and 3DP is to improve patient to physician communication by giving the patient a different 
perspective of her case, improving the explanation of a specific medical condition or 
treatment. Other possible application includes surgical guidance for target localization, 
where 3D printed patient-specific tools (with a reference AR marker attached) can be placed 
on rigid structures, such as bone, and used as a reference for the navigation. This application 
can be especially useful for orthopedic and maxillofacial surgical procedures in which bone 
tissue surface is easily accessed in the surgical field.” 

 
3. In order to describe the differences between Visualization and Registration methods, we have 

improved the description of the 3D Slicer module. In addition, the differences between both 
methods have been further explained in protocol sections. 
 

4. Segmentation might be a difficult task for some diseases, even more, if the region of interest 
includes other tissue than bone.  To answer the reviewer’s concerns, we have added an 
explanation in section 2.2.2.1 of how to perform the segmentation step. We think that the 
whole protocol is now easier to follow and, although it may seem complex at some points, 
the document will be a good step-by-step guide for the reader when combined with the final 
video. 

 
5. We apologize for the problems experienced when testing the version of the code available 

during the review. The 3D Slicer module has been updated and new functionalities have been 
added. One of the main improvements is the addition of a new button which allows the user 
to restart the process without the need of restarting 3D slicer when the button is pressed.  

 
 
  



Minor Concerns: 
1. Previous research proposed an AR method using a mobile device. You can refer to this article. 
Z. Fan, et al.: 3D Interactive Surgical Visualization System using Mobile Spatial Information 
Acquisition and Autostereoscopic Display, Journal of Biomedical Informatics, Vol.71, pp.154-164, 
2017. 
2. You can mark some important components in figures for better understanding. For example, 
you can mark "3D CT model" and "3D printed marker reference". 
3. A flowchart of the proposed method can be added for better understanding. 
 
Answer: 
The following paragraphs include our responses to the reviewer’s minor concerns: 
 
1. We would like to thank the reviewer for identifying that reference, that has been included in 

the introduction section of our paper (reference number 10).  
 

2. Considering the reviewer comment, Figures 2 and 3 have been modified by remarking the 
different elements in the image. 

 
3. A flowchart could help in understanding the method. However, we believe that the final video 

will serve as a flowchart and adding and extra figure illustrating the steps of the protocol will 
extend the paper length, so we did not include a flowchart. 
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